
Add or remove a 
digital signature in 
Office files 
This article explains digital signatures (also known as digital ID), what they 
can be used for, and how you can use digital signatures in the following 
Microsoft Office programs: Word, Excel, and PowerPoint. 

In this article 
Create a signature line in Word or Excel  

Sign the signature line in Word or Excel  

Remove digital signatures from Word or Excel  

Add invisible digital signatures in Word, Excel, or PowerPoint  

Remove invisible digital signatures from Word, Excel, or PowerPoint  

What is a digital signature?  

Signature lines in Word and Excel  

Invisible digital signatures in Word, Excel, or PowerPoint  



Create a signature line in Word or 
Excel 

1. In the document or worksheet, place your pointer where you want 
to create a signature line. 

2. On the Insert tab, in the Text group, click the Signature Line list, and 
then click Microsoft Office Signature Line. 

3. In the Signature Setup dialog box, type information that will appear 
beneath the signature line: 

 
o Suggested signer     The signer's full name. 
o Suggested signer's title     The signer's title, if any. 
o Suggested signer's e-mail address     The signer's e-mail 

address, if needed. 
o Instructions to the signer     Add instructions for the signer. 

4. Select one or both of the following check boxes: 
o Allow the signer to add comments in the Sign dialog box     

Allow the signer to type a purpose for signing. 
o Show sign date in signature line     Signature date will appear 

with signature. 

Tip   To add additional signature lines, repeat these steps. 

Note   If the document remains unsigned, the Signatures Message Bar 
appears. Click View Signatures to complete the signature process. 
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Sign the signature line in Word or 
Excel 
When you sign a signature line, you add a visible representation of your 
signature and a digital signature. 

 

1. In the file, right-click the signature line. 

Note   If the file opens in Protected View, click Edit Anyway, if the file 
is from a reliable source. 

2. From the menu, select Sign. 
o To add a printed version of your signature, type your name in 

the box next to the X. 

The signature line 

o To select an image of your written signature, click Select Image. 
In the Select Signature Image dialog box, find the location of 
your signature image file, select the file that you want, and then 
click Select. 

Notes   For customers using Chinese- (Traditional or 
Simplified), Korean-, or Japanese-language versions, the Stamp 
Signature Line option appears. 

In addition, you can sign a signature line by double-clicking the 
signature line. Type your name next to the X. Or, in the 



Signature Pane, in the Requested Signatures section, click the 
arrow next to the signature. From the menu, select Sign. 

o To add a handwritten signature (Tablet PC users only), sign 
your name in the box next to the X by using the inking feature. 

o Click Sign. 
o The red Signatures button appears at the bottom of the 

document or worksheet. 

The following image shows the Signatures button. 
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Remove digital signatures from Word 
or Excel 

1. Open the document or worksheet that contains the visible signature 
you want to remove. 

2. Right-click the signature line. 
3. Click Remove Signature. 
4. Click Yes. 

Note   In addition, you can remove a signature by clicking the arrow next 
to the signature in the Signature Pane. Click Remove Signature.  
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Add invisible digital signatures in 
Word, Excel, or PowerPoint 



To protect the authenticity of a document's content, you can add an 
invisible digital signature. Signed documents have the Signatures button 
at the bottom of the document. 

 

1. Click the File tab. 
2. Click Info. 
3. Under Permissions, click Protect Document, Protect Workbook or 

Protect Presentation. 
4. Click Add a Digital Signature. 
5. Read the Word, Excel, or PowerPoint message, and then click OK. 
6. In the Sign dialog box, in the Purpose for signing this document box, 

type the purpose. 
7. Click Sign. 

After a file is digitally signed, the Signatures button appears, and the file 
becomes read-only to prevent modifications. 
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Remove invisible digital signatures 
from Word, Excel, or PowerPoint 

1. Open the document, worksheet, or presentation that contains the 
invisible signature you want to remove. 



2. Click the File tab. 
3. Click Info. 
4. Click View Signatures. 
5. The document, worksheet, or presentation view returns, and the 

Signatures pane appears. 
6. Next to the signature name, click the arrow. 
7. Click Remove Signature. 
8. Click Yes. 
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What is a digital signature? 
A digital signature is an electronic, encrypted, stamp of authentication on 
digital information such as e-mail messages, macros, or electronic 
documents. A signature confirms that the information originated from the 
signer and has not been altered.  

Signing certificate and certificate authority 

Signing certificate     To create a digital signature, you have to have a 
signing certificate, which proves identity. When you send a digitally-
signed macro or document, you also send your certificate and public key. 
Certificates are issued by a certification authority, and like a driver’s 
license, can be revoked. A certificate is usually valid for a year, after 
which, the signer must renew, or get a new, a signing certificate to 
establish identity.  

Note   You can learn more about public and private keys in this article. 

Certificate authority (CA)     A certificate authority is an entity similar to a 
notary public. It issues digital certificates, signs certificates to verify their 
validity and tracks which certificates have been revoked or have expired. 
Microsoft Office has several solutions for obtaining certificates through 
Office Marketplace, Digital Signing. 



Digital signature assurances 

 Authenticity     The signer is confirmed as the signer.  
 Integrity     The content has not been changed or tampered with 

since it was digitally signed.  
 Non-repudiation     Proves to all parties the origin of the signed 

content. Repudiation refers to the act of a signer denying any 
association with the signed content.  

 Notarization     Signatures in Word, Excel, or PowerPoint files, which 
are time stamped by a secure time-stamp server, under certain 
circumstances, have the validity of a notarization.  

To make these assurances, the content creator must digitally sign the 
content by using a signature that satisfies the following criteria:  

 The digital signature is valid. 
 The certificate associated with the digital signature is current (not 

expired). 
 The signing person or organization, known as the publisher, is 

trusted. 

Important   Signed documents, which have a valid time stamp, are 
considered to have valid signatures, regardless of the age, or 
revocation status, of the signing certificate. 

 The certificate associated with the digital signature is issued to the 
signing publisher by a reputable certificate authority (CA). 
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Signature lines in Word and Excel 
A signature line resembles a typical signature placeholder that might 
appear in a printed document. However, it works differently. When a 
signature line is inserted into an Office file, the author can specify 
information about the intended signer, and instructions for the signer. 



When an electronic copy of the file is sent to the intended signer, this 
person sees the signature line and a notification that their signature is 
requested. The signer can: 

 Type a signature. 
 Select a signature digital image. 
 Write a signature by using the inking feature of the Tablet PC. 

When the signer adds a visible representation of a signature to the 
document, a digital signature is added at the same time to authenticate 
the signer's identity. 

 

Important   A digitally-signed document becomes read-only to prevent 
modifications. 

Reducing risk with digital signatures 

Using signature lines in Office files makes it possible for organizations to 
reduce risk when you use electronic transactions and to streamline paper 
processes for contracts or other agreements. Digital signatures provide a 
record of exactly what was signed and can be verified in the future. 

When the signer adds a visible signature to the document, a digital 
signature is added at the same time to authenticate identity. After a 
document is digitally signed, it becomes read-only to prevent 
modifications. 
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Invisible digital signatures in Word, 
Excel, or PowerPoint 



An invisible digital signature, such as a visible digital signature line, 
assures the authenticity, integrity, and origin of a document. You can add 
invisible digital signatures to Word documents, Excel workbooks, and 
PowerPoint presentations. 

Signed documents will have the Signatures button at the bottom of the 
document. In addition, for signed documents, signature information 
appears in the Info section that you see after you click the File tab. 
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Applies To: Excel 2013, Excel 2010, PowerPoint 2010, Word 2013, Word 
2010, PowerPoint 2013, Office Shared 2013 

  

  



Add or remove a 
digital signature in 
Office documents 
This topic explains what a digital signature (also called digital ID) is, what 
it can be used for, and how you can use digital signatures in Microsoft 
Office Word 2007, Microsoft Office Excel 2007, and Microsoft Office 
PowerPoint 2007. For more information, see the white paper Digital 
Signing of Microsoft 2007 Office System Documents. 

The Office Blog  
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What is a digital signature? 
Digital signatures is used to authenticate digital information — such as 
documents, e-mail messages, and macros — by using computer 
cryptography. Digital signatures help to establish the following 
assurances: 

 Authenticity     The digital signature helps to assure that the signer is 
who he or she claims to be. 

 Integrity     The digital signature helps to assure that the content has 
not been changed or tampered with since it was digitally signed. 

 Non-repudiation     The digital signature helps to prove to all parties 
the origin of the signed content. "Repudiation" refers to the act of a 
signer's denying any association with the signed content. 

To make these assurances, the content creator must digitally sign the 
content by using a signature that satisfies the following criteria: 

 The digital signature is valid. 
 The certificate associated with the digital signature is current (not 

expired). 
 The signing person or organization, known as the publisher, is 

trusted. 
 The certificate associated with the digital signature is issued to the 

signing publisher by a reputable certificate authority (CA). 

The 2007 Microsoft Office system programs detect these criteria for you 
and alert you if there is a problem with the digital signature. For more 
information, see the article How to tell if a digital signature is trustworthy. 
You can also get or create your own digital signature, or learn more 
about digital signatures in macro projects. 
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How can digital signatures be used in 
Office documents? 
There are two different ways you can use digital signatures to sign Office 
documents. You can either: 

 Add visible signature lines to a document to capture one or more 
digital signatures. 

 Add an invisible digital signature to a document. 

The differences between these two methods and details about how to 
digitally sign a document in either of these two ways are described in the 
following sections. 
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Add one or more signature lines to a 
document 
The 2007 Microsoft Office system introduces the ability to insert a 
signature line into a document. You can insert signatures lines only into 
Word documents and Excel workbooks. 

A signature line looks like a typical signature placeholder that might 
appear in a print document, but it works differently. When a signature 
line is inserted into an Office document, the document author can specify 
information about the intended signer, as well as instructions for the 
signer. When an electronic copy of the document is sent to the intended 
signer, this person sees the signature line and a notification that his or her 
signature is requested. The signer can click the signature line to digitally 
sign the document. The signer can then either type a signature, select a 
digital image of his or her signature, or write a signature by using the 



inking feature of the Tablet PC. When the signer adds a visible 
representation of his or her signature to the document, a digital signature 
is added simultaneously to authenticate the identity of the signer. After a 
document is digitally signed, it will become read-only to prevent 
modifications to its content. 

 

The ability to capture digital signatures by using signature lines in Office 
documents makes it possible for organizations to use paperless signing 
processes for documents like contracts or other agreements. Unlike 
signatures on paper, digital signatures can provide a record of exactly 
what was signed and they allow the signature to be verified in the future. 

To add a signature line to a document 

1. Place your pointer in the location in your document where you want 
to add a signature line. 

2. On the Insert tab, in the Text group, point to the arrow next to 
Signature Line, and then click Microsoft Office Signature Line. 

3. In the Signature Setup dialog box, type information about the 
person who will be signing on this signature line. This information is 
displayed directly beneath the signature line in the document. Do 
any of the following: 

o Type the signer's name in the Suggested signer box. 
o Type the signer's organizational title (if any) in the Suggested 

signer's title box. 
o Type the signer's e-mail address (if any) in the Suggested 

signer's e-mail address box. 



4. If you want to provider the signer with any instructions, type these 
instructions in the Instructions to signer box. These instructions are 
displayed in the Signature dialog box that the signer uses to sign the 
document. 

5. If you want the signer to be able to add comments along with the 
signature, select the Allow the signer to add comments in the Sign 
dialog check box. 

6. If you want to show the date when the signature is added in the 
signature line, select the Show sign date in signature line check box. 

7. Click OK. 
8. To add additional signature lines, repeat steps 1 through 7. 
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Sign the signature line in a document 
When you sign the signature line in an Office document, you add both a 
visible representation of your signature and a digital signature. 

1. In the document, double-click the signature line where your 
signature is requested. 

2. In the Sign dialog box, do one of the following: 
o To add a printed version of your signature, type your name in 

the box next to the X. 
o To select an image of your written signature, click Select Image. 

In the Select Signature Image dialog box, find the location of 
your signature image file, select the file that you want, and then 
click Select. 

o To add a handwritten signature (Tablet PC users only), sign 
your name in the box next to the X by using the inking feature. 

o Click Sign. 
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Add an invisible digital signature to a 
document 
If you do not need to insert visible signature lines into a document, but 
you still want to provide assurance as to the authenticity, integrity, and 
origin of a document, you can add an invisible digital signature to the 
document. You can add invisible digital signatures to Word documents, 
Excel workbooks, and PowerPoint presentations. 

Unlike an Office signature line, an invisible digital signature is not visible 
within the contents of the document itself, but recipients of the document 
can determine that the document has been digitally signed by viewing 
the document's digital signature or by looking for the Signatures button 
on the status bar at the bottom of the screen. 

 

After a document has been digitally signed, it becomes read-only to 
prevent modifications. 

1. Click the Microsoft Office Button , point to Prepare, and then click 
Add a Digital Signature. 

2. If you want to state your purpose for signing the document, type 
this information in the box under Purpose for signing this document 
in the Sign dialog box. 

3. Click Sign. 

Digitally sign with a stamp 
This topic explains how you can digitally sign a Microsoft Office 
document with a stamp in Word documents and Excel workbooks. If a 
document is changed after it is signed, the signature is invalidated.  

Sign an Office document with an image 



When you sign the stamp signature line in an Office document, you add 
both a visible stamp and a digital signature. 

1. In the document, double-click the stamp signature line where your 
signature is requested, and then click OK. 

2. In the Sign dialog box, click Select Image. 
3. In the Select Signature Image dialog box, find the location of your 

signature image file, select the file that you want, and then click 
Select. 

4. Click Sign. 

Insert a stamp signature line into an Office document 

The feature is only available if you: 

 Are using the Chinese (Simplified), Chinese (Traditional), Japanese, 
or Korean language version of Microsoft Office, or 

 Installed the 2007 Microsoft Office system Multi-Language Pack for 
one of these languages, or 

 Enabled support for one of these languages through the Microsoft 
Office Language Settings. 

Note   Stamp signature lines are only available for Word documents and 
Excel workbooks. 

1. Place your pointer in the location in your document where you want 
to add a signature line. 

2. On the Insert tab, in the Text group, point to the arrow next to 
Signature Line, click Stamp Signature Line, and then click OK. 

3. In the Signature Setup dialog box, type the information about the 
person who is signing this document. This information is displayed in 
the stamp signature line. Do any of the following: 

o Type the signer's name in the Suggested signer box. 
o Type the signer's organizational title (if any) in the Suggested 

signer's title box. 



o Type the signer's e-mail address (if any) in the Suggested 
signer's e-mail address box. 

4. If you want to provide the signer with any instructions, type these 
instructions in the Instructions to signer box. These instructions are 
displayed in the Signature dialog box that the signer uses to sign the 
document. 

5. If you want the signer to be able to add comments along with the 
signature, select the Allow the signer to add comments in the Sign 
dialog check box. 

6. If you want to show the date when the signature is added in the 
signature line, select the Show sign date in signature line check box. 

7. Click OK. 
8. To add additional stamp signature lines, repeat steps 1 through 7. 
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Remove a digital signature from an 
Office document 
You can remove a digital signature from a Microsoft Office document 
that has been digitally signed. 

1. Open the document that contains the signature you want to 
remove. 

2. Click the Microsoft Office Button , point to Prepare, and then click 
View Signatures. 

3. In the Signatures task pane, point to the signature that you want to 
remove, click the arrow that appears on the right, and then click 
Remove Signature. 

4. When you are asked if you want to permanently remove the 
signature, click Yes. 
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